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Plane Wave – normal incidence 

Introduction 

The aim of the training given below is to point out main properties and behaviour of the plane wave 

propagating in an isotropic medium and incident normally at the media boundaries. 

All examples used here were prepared in free CAD QW-Modeller for QuickWave and the models 

preparation procedure is described in separate documents. All examples considered herein are 

included in the QW-Modeller and QuickWave STUDENT Release installation as both, QW-Modeller 

and QW-Editor projects. 
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Plane wave in a free space 

Theory 
A plane wave is the simplest form of the Maxwell’s equations solution. Its name refers to the shape 

of a wave front (constant phase surfaces, perpendicular to the direction of propagation) of a 

propagating wave: 

 

Fig 1 Plane wave in a free space. 

The basic parameters of a plane wave are: wavelength , frequency f, and magnitude A. Wavelength 

is related to frequency and propagation speed (thus also the parameters of the medium in which 

wave propagates) according to the following formula: 



 11
==f  

where: 

 - medium permittivity 

 - medium permeability 

 

There are four main properties of a plane wave: 

1. Propagation speed - depends on medium parameters: 
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 is a speed of light in vacuum, μr and εr stand respectively for the 

relative permeability and permittivity of a medium in which the wave propagates. 

 

2. Electric and magnetic fields are perpendicular to the direction of propagation: 

Ek


⊥  and Hk


⊥  



Plane Wave – normal incidence                                                                                                          

                                                                                                          www.qwed.eu    

3 

3. Electric and magnetic fields are perpendicular to each other: 

HE


⊥  

4. Wave impedance is equal to intrinsic impedance of the medium: 
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The above given formulae apply to a plane wave propagating in a lossless medium. When considering 

a plane wave in a lossy medium a general formula for sinusoidal plane wave is given with a complex 

notation as follows: 

rtjeEE

 −= 0  

where 0E


stands for a complex amplitude,  is a pulsation, t – time,  zyxr ,,=


 – radius vector and 

 – propagation constant, given with 

)(  jjj +=+=  

where  is a phase constant and   an attenuation coefficient. 

 

Paragraph objective 
1) Study of the basic properties of a plane wave. 

2) Observations of a wavelength change as a frequency function. 

3) Observations of a wavelength change as a function of material parameters: permittivity and 

permeability. 

4) Observations of field envelope changes as a function of medium lossess. 

 

Tutorials 
For the tutorials the basic ppw1.QWpro model and its modifications will be used. The description of 

how to create such model step by step can be found in a separate document. 

 

Basic properties of a plane wave 
The ppw1.QWpro model should be loaded to QW-Modeller and the electromagnetic simulation in 

QuickWave needs to be run. The simulation is run with default parameters of the model, by pressing 

 button from Simulation tab. 
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QW-Simulator runs with Log window opened and Log Output tab active. Detailed description of all 

output comments written in the log window can be found in QuickWave manual. Press  button 

in 2D/3D Fields tab of QW-Simulator to open fields visualisation window and observe the propagating 

wave. Maximise the window for your convenience. In the window visible are: the structure and a 

cross section through the middle of the parallel plate line, in the plane parallel to the direction of 

wave propagation to enable convenient visualisation. Enable continuous display refresh by pressing 

 icon (or by pressing "D" from keyboard). In the widow title bar "/DYN" should now appear. 

The field component that is currently displayed is Ex, which in the considered case stands for the 

electric field component parallel to the direction of wave propagation. According to Property 2 of a 

plane wave, electric and magnetic fields are perpendicular to the direction of wave propagation, that 

is why the Ex component is zero. Switch to Ez and then to Hy components by clicking the appropriate 

buttons in the Components tab: . Those two components obey the 

Property 2 of a plane wave, thus when displayed the moving sinusoidal wave can be seen. We 

recommend adjusting the magnitude of the displayed component using  button. The 

exemplary display of the electric field component is shown Fig 2. 

 

Fig 2 Example of Ez component of electric field. 

The display confirms that the wave propagates in  direction and the electric and magnetic fields are 

along  directions respectively, what proves the Property 3 of a plane wave. 

 

It should be reminded that the frequency set for this model is 4GHz, thus the wavelength in a free 

space is calculated as follows: 

mmm
f

c

f

v
75075.0 ====  
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This value can be confirmed in the simulation. Press  button in 1D Fields tab and then change 

the display to show Ez component. Suspend the simulation by pressing  button. Fig. 3 shows 

the display in a random simulation moment after suspending the calculation. To calculate the 

wavelength it is required to measure the distance between two nearest points of the same phase. It 

is done using markers (blue and red) and the distance is read on the left side of the window. In this 

case  what is consistent with the theoretical calculations. 

The QW-Simulator can be now closed. 

 

Fig 3 Example of 1D view of Ez component. 

 

Relation between a frequency and a wavelength 
The formula for a wavelength calculation has been confirmed with simulation. Now the dependence 

between a frequency and a wavelength will be investigated. For that purpose you can open a ready 

to run ppw2.QWpro file or open and modify the ppw1.QWpro example in QW-Modeller. If you are 

modifying ppw1.QWpro file, change the excitation parameters using dialogue windows of respective 

ports, which can be edited from the project tree (see Fig 4). Click over Ports (to unfold the menu) and 

double click over the SourcePort port to open its configuration dialogue (see Fig 5). In the Parameters 

tab we set the excitation frequency to 8 GHz. The same change should be done for LoadPort port. 

Save the project with a new name and run simulation by pressing  in Simulation tab. 
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Fig 4 ppw1.QWpro project tree. 
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Fig 5 Port properties dialogue. 

The wavelength should be measured as previously (open 1-D display window with  button, pick 

the correct component, suspend the simulation, mark two points of the same phase). The result of 

this measurement is shown in Fig 6. 
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Fig 6 Measurement of wavelength at 8GHz. 

The theoretical wavelength is: 

mmm
f

c

f

v
5.370375.0 ====  

and it differs from the value calculated in simulation. This discrepancy is due to the space 

discretisation setting, which directly determines the accuracy of wavelength calculation. In the 

considered case the cell dimension in the direction of wave propagation equals 1 mm and that is the 

limit of wavelength calculation accuracy.  

 

Relation between a wavelength and medium parameters (permittivity and permeability) 
The relation between a wavelength and medium parameters can be observed using ppw3.QWpro file 

that needs to be loaded in QW-Modeller. 

It is also possible to modify ppw1.QWpro, which for that purpose should be opened in QW-Modeller. 

To observe the relation between a wavelength and material properties with good accuracy it is 

required to change the space discretisation. In the Model tab press Settings  icon and in the 

appearing dialogue set the cell size in the direction of wave propagation (X dir) to 0.25 mm (see Fig. 

7). 
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Fig 7 Dialogue window for mesh settings. 

Now, the new medium in which the wave will propagate should be introduced and assigned. The 

procedure of doing this is as follows: 

• In Geometry tab press  button. The dialogue as in Fig 8 will be opened. 

• Press Add button. A window for defining medium parameters, as in Fig.9 appears. Define 

the material name as “dielectric” and assign permittivity value of εr=4. If required, 

material colour can be changed, using Pen option. 
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Fig 8 Dialogue window for materials editing. 

 

Fig 9 Example of correctly filled window for new material adding. 
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It is required to assign the new medium to the box in which the wave propagates. For that purpose 

pick the Box object from the project tree by clicking on it and in the Data tab of Property Editor (see 

Fig. 10) click on the Medium row. The Set Medium option will be available. 

 

Fig 10 Element properties window of Data tab. 

Pressing this option invokes Project Media dialogue (Fig. 11), from where "dielectric" medium should 

be chosen. 
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Fig 11 Dialogue window for materials available in the project. 

Save the project with a new name and run simulation using  button. 

In the QW-Simulator measure the wavelength for the considered case. According to the formula 

given above, the wavelength is equal to  mmm
f

c

f

c

f

v

r

5.370375.0
4

=====


 . Due to 

improved space discretisation the precise wavelength value of 37.5 mm is calculated in the 

simulation. 

The display observation allows noticing the change of plane wave speed (Property 1). It is advised to 

check how the speed of a plane wave depends on μr change. 

 

Envelope shape in lossy media 
In the scenarios considered above the medium in which a plane wave propagated was a lossless 

medium. The observed fields' envelope was a straight line. In this paragraph a lossy medium will be 

considered and its influence on envelope shape will be observed. 

Open example ppw4.QWpro in QW-Modeller or modify ppw1.QWpro in the following way. Open the 

Project Media dialogue (Fig. 8) as it was done before and add the "dielectric" medium. The window 

as in Fig 9 will appear. Modify the Sigma parameter to be equal to 0.1 (it is expressed in 
m

S
). Accept 

the changes by pressing OK button and save the project with a new name. 



Plane Wave – normal incidence                                                                                                          

                                                                                                          www.qwed.eu    

13 

The attenuation coefficient , determining the envelope shape, can be calculated analytically using 

the following formula for the propagation constant: 

78.8541.18)( jjjj +=+=+= 
 

Real part 41.18}Re{ ==   

The attenuation coefficient may be also calculated from the simulation data in the 1D display 

window following the below formula: 

)(

)(

)(
ln

12

2

1

xx

xE

xE

−










=   

where: 

• x1 first marker localisation (in mm) (e.g. at the beginning of guide) 

• x2 second marker localisation (in mm) (e.g. at the end of guide) 

• E(x1) electric field magnitude read for x1 position 

• E(x2) electric field magnitude read for x2 position 

The display showing exemplary makers’ position for attenuation coefficient calculation together with 

their values is shown in Fig 12. 

 

Fig 12 Electric field envelope for lossy medium. 

 

The calculated attenuation coefficient   value is: 
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37.18
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−
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=
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  

Good agreement between theoretical calculations and simulation data is achieved. 

It is recommended to change   parameter to 1 and observe the envelope shape change. 

 

Summary 
In this paragraph it has been shown how to use QuickWave software for testing the basic properties 

of a plane wave. 
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Plane wave at the media boundary  
In previous paragraph, a plane wave propagation in homogeneous, linear and isotropic medium has 

been discussed. In this paragraph a plane wave incident at the two homogeneous media boundary 

will be considered. The model used in this paragraph is named ppw5.QWpro. It is assumed that the 

wave incidents normally at the media boundary. 

 

Theory 
Fig. 13 shows a situation in which a plane wave incidents at the media boundary. In this case 3 types 

of waves can be described:  

• incident wave, +

1E


, +

1H


, 

• reflected wave, −

1E


, −

1H


, 

• transmitted wave, 2E


, 2H


 

 

Fig 13 Graphic scheme of normal wave incidence at two mediums border. 

In this case a reflection coefficient, describing a reflected to an incident field ratio, can be defined: 
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This allows determining the formulas describing the waves defined above:  

Incident wave: 
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 −+ =
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Reflected wave: 
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Transmitted wave: 
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The reflection coefficient  can be calculated due to the assumption that impedance at the media 

boundary must be continuous: 

12

12

ZZ

ZZ

+

−
=  

The above wave formulas confirm that in medium 1 incident and reflected waves merge, giving 

partially standing wave, as constant maxima and minima of fields’ envelopes distribution in space 

exists (a standing wave property) and also the energy is transferred in a direction of an incident wave 

propagation (typical for traveling wave). In case of medium 2, only traveling wave exists. 

The predominant wave type in medium 1 can be determined using the standing wave ratio SWR (or 

VSWR) defined as the ratio of maximum field envelope (electric or magnetic) to minimum field 

envelope: 

min

max

)(

)(

zE

zE
SWR =  

SWR is related to a reflection coefficient according to the following formula: 



Plane Wave – normal incidence                                                                                                          

                                                                                                          www.qwed.eu    

17 

||1

||1

−

+
=SWR  

Please note that the value of SWR varies in the range (1; ∞). If SWR tends to 1, we deal with a more 

traveling-like wave. 

 

Paragraph objectives 
1) Analysis of a reflection coefficient and a standing wave ratio for a plane wave incident at a 

boundary of two dielectrics 

2) Analysis of a reflection coefficient and a standing wave ratio for a plane wave incident on a 

perfect conductor 

 

Tutorials 
Two scenarios will be considered: a plane wave incident at a concrete wall and on a flat metal 

surface. 

 

Normal incidence of a plane wave on the two lossless dielectric media boundary 
Model considered herein works at 5GHz, which according to IEEE 802.11 specification, is a wireless 

communication frequency. The wave propagates in air, incidents on a concrete wall and further 

propagates in this medium. The reflection coefficient, SWR, reflected and transmitted power will be 

determined. Theoretical calculations will be compared with the simulation results. 

The parameters of a concrete wall are assumed as follows: εr2=4.5, μr2=1, σ=0. 

Characteristic impedances of the two media are calculated as: 

][1200
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Thus the reflection coefficient equals: 

36.0
12

12 −
+

−
=

ZZ

ZZ
 

Negative value of the reflection coefficient means that the wave propagates from a medium of 

higher impedance. 

Standing wave ratio in a first medium is calculated as follows: 

125.2
||1

||1


−

+
=SWR  
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The calculated value indicates that the wave in first medium is more like a traveling wave than a 

standing wave. 

The above parameters should be now extracted from the simulation results. Start simulation of the 

ppw5.QWpro scenario using  button in Simulation tab. Open 1D visualization window by clicking  

 button in 1D Fields tab. Switch to existing field component i.e. Hy. The media boundary should 

be clearly visible ( ). If not, adjust the scale using Scaling dialogue available with Alt + S 

keyboard combination. Place markers at the envelope maximum and minimum according to standing 

wave ratio definition. Standing wave ratio can be now calculated automatically using Attn button in 

Function tab of 1D Fields window. The SWR value is visible in Markers tab. 

The window display including markers positions is shown in Fig 14. 

 

Fig 14 Magnetic field Hy element envelope and temporary waveform (example). 

The value of SWR calculated from simulation data is very close to the theoretical value. Based on that 

value, the reflection coefficient can be calculated as follows: 

1

1
||

+

−
=

SWR

SWR
 

The above formula allows calculating an absolute value of the  coefficient. To determine the sign of 

reflection coefficient, the fields' envelope must be observed. If the magnetic field envelope takes 

maximum value at the media boundary (and respectively, envelope of electric field takes minimum) 

the wave propagates from a medium of higher impedance (to medium of lower impedance) and the 

sign of reflection coefficient is minus. If opposite the sign is plus. 
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Power reflected from the concrete wall will be now calculated. Assuming that the concrete wall 

reflects  of electric field and  of magnetic field, the reflected power is proportional to 2: 

13.036.0 22 =  

This means that 13% of a plane wave power is reflected from the concrete wall and 87% is 

transmitted further through a concrete material. 

 

Normal incidence of a plane wave on a perfect conductor surface 
In this case an envelope of a standing wave will be demonstrated. Assuming that a plane wave 

incidents normally on a perfect metal (perfect electric conductor – PEC) with impedance equal to 0, 

reflection coefficient is equal: 

1
0

0

1

1 −=
+

−
=

Z

Z
 

The SWR in this case equals to: 

→
−

+
=

1

1
SWR  

According to SWR value, the wave in a first medium (air) is a standing wave. No energy is transferred 

through the media boundary and the fields in envelope nodes have values equal to 0. 

The above values and conclusions may be confirmed in electromagnetic simulation. Open the ready 

to run ppw6.QWpro model in QW-Modeller or open ppw5.QWpro and modify it adequately 

performing the following: 

- Remove the LoadPort port since it is not required in this case. Pick the LoadPort port on the 

project tree (see Fig. 15) and remove with Delete option available under right mouse button. 

- Change the medium of section 2 to metal by editing Medium parameter of the section2 

object (see Fig. 16). 

- Save the project with a new name. 
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Fig 15 How to delete port (element) from the project. 
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Fig 16 Element properties edition. 

Run the simulation by pressing  button in Simulation tab. Open 1D display window using  

button in 1D Fields tab. Switch to excisting field component i.g. Hy. Fig. 17 shows the display that 

should be seen. 
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Fig 17 Magnetic field envelope of a wave normal to PEC surface. 

It can be seen that there is no propagation in perfect metal. The values of magnetic field in the 

envelope nodes are close to 0. The values are not 0 due to the numeric accuracy limit – the smaller 

the mesh cell dimension will be, the closer field value to 0 would be. 

 

Summary 
In his paragraph the fields’ envelopes of a plane wave, incident on different media boundary was 

demonstrated. It is recommended to investigate the EM fields’ envelopes in case when a plane wave 

propagates from a medium of lower impedance and a plane wave incidents perpendicularly on a 

lossy dielectric. 
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Plane wave at the three media layered structure 
Plane wave incident on three media boundary is the most interesting and complex case. The 

definitions of matching, quarter wavelength transformer and half wavelength transformer will be 

introduced and explained. 

 

Theory 
The media structure discussed in his paragraph is shown in Fig 18. 

 

Fig 18 3-medium structure and normal plane wave incident. 

In the considered case a plane wave propagating in medium 1 incidents at the boundary between 

medium 1 and 2, it is partially reflected (according to the rules described before) and then 

propagates further in medium 2 until it reaches the boundary of medium 3. At the medium 3 

boundary a plane wave partially reflects and the remaining wave further propagates in medium 3. 

The wave reflected from the boundary of medium 2 and medium 3, propagating in medium 2, is 

partially transmitted to medium 1, thus it influences the amount of total reflection seen in medium 1. 

The above reflections scenario can be simplified to a scenario of a plane wave incident at the 

boundary of two different media. It is done by introducing a variable describing the impedance of 

medium 3 transformed by a slab of medium 2 (it is an impedance “seen” by a wave incident at 

medium 2 boundary). This wave impedance is defined with the following formula: 
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The reflection coefficients are calculated for both boundaries as follows: 

• Reflection coefficient 2,3(between medium 2 and 3) 

23
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−
=  

• Reflection coefficient 1,2  (between medium 1 and 2) 
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The corresponding standing wave ratios are calculated as: 

||1
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It is worth noting that in specific cases, )( 2dtg   component in the formula for transformed 

impedance equals 0 or . Those situations will be considered below. 

 

Quarter wavelength transformer 

When the thickness (d) of medium 2 is equal to ¼ of a wavelength in this medium (
4

2=d ), 

)( 2dtg  component equals to: 

=





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
 tgtgdtg  

The formula for transformed impedance simplifies to: 

3

2

2
2

)(
)(

Z

Z
dZw =−  

Please note that the tangent function is periodic with period equal to , so the above formula is 

correct for medium slab thicknesses of 
24

22 
+ n  , where n is an absolute positive number. 
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Half wavelength transformer 

When the thickness (d) of medium 2 is equal to half of a wavelength in this medium (
2

2=d ), 

)( 2dtg   component equals to: 

( ) 0
2

2
)( 2

2

2 ==







= 






 tgtgdtg  

The formula for transformed impedance simplifies to: 

32 )( ZdZw =−  

In this case the above formula is correct for slab thicknesses of 
2

2n , where n is an absolute 

positive number. 

 

Impedance matching 
The wave transformers introduced above are commonly used for impedance matching of different 

media. This means that the parameters of medium 2 are chosen to assure no reflections in medium 

1. 

Quarter wavelength transformer allows matching media of different impedances providing that the 

impedance of the transformer material equals: 

312 ZZZ =  

Half wavelength transformer is transparent for the wave as long as its thickness equals to 
2

2n  at a 

chosen frequency. 

 

Paragraph objectives 
1)  Analysis of the fields’ envelopes for three media layered structure. 

2) The design of impedance matching in three media layered structure. 

 

Tutorials 
The scenario with a concrete wall considered before is revert and it will be demonstrated how to 

accomplish an impedance matching for air-concrete-air structure using a quarter wavelength 

transformer. 
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Plane wave incident normally at the layered structure of three lossless media: air-concrete-air 
In the previous paragraph the reflection of a plane wave incident at the air-concrete boundary was 

considered. Assume more practical situation when a plane wave incidents at the layered structure of 

air-concrete-air, which corresponds to a scenario where WiFi signal is crossing room’s wall. 

For calculation simplicity, it is assumed that the relative permittivity of concrete equals to 4. The 

thickness of a room’s wall is 7.5 mm. A plane wave incidents at the dielectric layered structure under 

the following conditions: 
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The wall thickness was chosen so that it equals to a quarter wavelength in a concrete material for 

excitation frequency of 5GHz. This does not assure the impedance matching because the 

312 ZZZ =  condition is not obeyed. In this case a partially standing wave in medium 1 is 

observed and reflections on the concrete wall boundaries are observed. Signal propagation through 

several walls can significantly decrease signal power and the reception will be not possible. 

To investigate the field’s envelope for the considered layered structure open ppw7.QWpro model in 

QW-Modeller and start simulation using  button in the Simulation tab. Open 1D display window 

using  button in 1D Fields tab of QW-Simulator. Switch to existing electric field component i.e. 

Ez. Fig. 19 shows the display that should be seen. 
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Fig 19 Electric field envelope and temporary waveform of 3- media example. 

The SWR value in medium 1 calculated from simulation data confirms the theoretical value. Similar 

calculations should be performed for medium 2. 

 

Plane wave incident normally at the layered structure of three lossless media: air-concrete-air 

– impedance matching 
The reflections in medium 1 can be eliminated when the impedance matching is assured. Since the 

impedances of medium 1 and 3 are equal, the half wavelength transformer (transparent for the 

wave) is considered. The thickness of a concrete wall needs to be changed to 
2

2  and the following 

value of transformed impedance is obtained: 
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And: 
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According to the above calculations, using 15 mm thick wall should eliminate reflections. To confirm 

this with electromagnetic simulation the ppw8.QWpro should be opened or ppw7.QWpro must be 

modified as follows: It is required to increase the wall thickness. On the project tree pick section2 

object and change its length in the Property Editor (see Fig. 20) to 15 mm. At the same time the 

length of section3 object needs to be decreased by 7.5 mm and its position in X direction needs to be 

shifted by the same value. The correct settings are shown in Fig. 21. 

 

Fig 20 Properties of section2 representing concrete wall. 
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Fig 21 Correct parameters after section3 modification. 

Save the project with a new name and run simulation by pressing  button in Simulation tab. 

Open 1D display window by pressing  button. Switch the view to existing electric field 

component i.e. Ez. Fig. 22 shows the display that should be seen. 
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Fig 22 Matching realized with half wave transformer. 

Simulation results have confirmed the theoretical calculations that using a half wavelength 

transformer assures the impedance matching in the considered scenario. 

 

Summary 
In this paragraph the possibilities of matching a dielectric layered structure has been demonstrated. 

It is recommended to design an impedance matching for 5GHz between air (medium 1) and a 

dielectric with relative permittivity εr=9 (medium 3) using quarter wave transformer. All three 

mediums have permeability μr=1. The medium parameters of medium 2 should be chosen 

appropriately. 

 


